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Uso del analizador logico para testear un
dispositivo de lectura de ROMs de Atari 2600

Estructura de Computadores

IMPORTANTE: La presentacion del estudio tedrico escrito es obligatoria para la realizacién de
la practicas. Se presentara un estudio por persona y se entregara al profesor durante la
sesion de practicas. El estudio ha de dar respuesta a cada una de las cuestiones y ha de ser
detallado, completo, claro y bien presentado. El profesor podra realizar preguntas o pedir
aclaraciones sobre el estudio teérico realizado. Ademas cada alumno debe llevar impreso el
enunciado.

1. Introduccion

El analizador légico es un instrumento de laboratorio que facilita enormemente el testado de
circuitos y sistemas digitales de alto nimero de entradas y salidas como, por ejemplo, las memorias de
acceso directo. Al igual que el osciloscopio, el analizador 16gico mide senales de tensidn, pero entre

ambos existen importantes diferencias:

« El osciloscopio puede medir simultaneamente un nimero reducido de senales (usualmente solo

2), mientras que analizador puede leer multitud de ellas (del orden de decenas).

» El osciloscopio mide niveles continuos de tensién, mientras que el analizador légico solo
establece si las senales estan por encima o por debajo de un determinado umbral. De esta forma
el analizador puede indicar el valor l6gico de una sefial (0 o 1), pero no puede concretar su nivel

exacto de tension.

+ El osciloscopio monitoriza y representa continuamente las sefiales. El analizador, por el
contrario, solo examina las sefales en ciertos instantes de tiempo para registrar su valor légico
en una memoria interna (la accién de leer y registrar el valor 16gico de las sefiales se denomina
captura). El analizador solo puede informarnos del valor l6gico que tienen las seinales en los

instantes de captura.

Los analizadores pueden realizar las capturas espaciadas en el tiempo en un periodo seleccionable,
para lo que disponen de un reloj interno. No obstante, también pueden configurarse para que realicen
las capturas cuando ocurra un flanco en una entrada especial (la entrada de reloj externo). Ademads
pueden configurarse para que empiecen a registrar los datos al detectar un determinado patrén en los
canales de datos (a este patron se le denomina palabra de disparo). Todo esto convierte al analizador en

una herramienta ideal para analizar el funcionamiento de buses digitales.

En nuestro laboratorio disponemos de analizadores logicos sobre PC, esto es, una tarjeta de
adquisiciéon y un programa sobre PC que funcionan como tal analizador, concretamente el modelo LA-

2132. En la presente practica se usara el dicho analizador para estudiar el proceso de lectura de una
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ROM, en concreto la ROM de un cartucho de la videoconsola Atari 2600. Dichas ROMS tienen una
capacidad de 4KBytes, esto es, 21x8 bits. En el laboratorio se realizara una lectura de todas sus 4K
posiciones de memoria. Esto se consigue generando todas las posibles direcciones de memoria, desde 0
hasta 4095 ($000 a $FFF en hexadecimal). Para ello se usard un contador de 12 bits construido
conectando en cascada tres contadores comerciales 74191 tal y como se muestra en la Figura 1. Dichos

contadores son disparados por el flanco de subida (véase el anexo de la tltima pagina).
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Figura 1: Conexionado de la placa

Usaremos el analizador légico para observar las sefiales digitales del circuito. La conexién del
analizador a la placa del circuito se hace a través de unas sondas o cables. El analizador 16gico opera en
dos fases: primero, adquiere el valor légico de las sefales y los almacena en su memoria interna;
después, representa estos valores en un monitor mediante una herramienta que facilita los recursos de
visualizacion y medida de tiempos. Ademas, el analizador permite salvar los datos capturados en un

fichero.

2. Objetivos

= Introducir el manejo del analizador légico.

= Realizar el testado a nivel 1dgico de un sistema digital sencillo, en concreto una placa disefiada

para leer ROMs de juegos de Atari 2600.

= Realizar un volcado de la ROM y comprobar experimentalmente la correccién del procedimiento

mediante el uso de un emulador de Atari 2600.

= Medir, de forma aproximada, tiempos de propagacion y frecuencias maximas de operaciéon del

circuito.
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3. Estudio tedrico

1. Estudie y comprenda el funcionamiento del circuito de la Figura 1 (el componente 74191 se

describe en el anexo de la Gltima pagina).

2. Suponga que los contenidos de las tres posiciones de ROM mas bajas ($000, $001 y $002) son
respectivamente $37, $A9 v $7E, y que el contenido de la posicién de memoria méas alta es $00.
Considere $FFF como estado inicial del contador. Suponiendo que tanto la ROM como los

contadores tienen un retraso nulo, complete el siguiente cronograma:

primera captura

RELOJ DE LA PLACA

LINEAS DE DIRECCION $FFF

LINEAS DE DATOS

3. En el cronograma anterior, suponga que analizador 16gico captura las sefiales a una frecuencia
cuatro veces superior a la del reloj de la placa y que la primera se realiza en el instante marcado
por la flecha. Marque sobre el cronograma cuando se realizarian el resto de las capturas e

indique los valores de las lineas de datos y direcciéon en cada una de ellas.

4. Vuelva a completar el cronograma siguiente suponiendo ahora que el conjunto de contadores
tiene un retraso Rc>0, la ROM un retraso Rr>0 y asumiendo que la suma de ambos retrasos es
menor a la mitad del periodo de reloj de la placa (es decir, debe suponer Rc+Rr < Tp/2, donde

Tp es el periodo de reloj de la placa). No olvide marcar los retrasos sobre el cronograma.

RELOJ DE LA PLACA

LINEAS DE DIRECCION sFFF

LINEAS DE DATOS

5. En el cronograma anterior, indique los valores de las lineas de direccion y datos que capturaria

el analizador légico si realiza las capturas en los flancos de bajada del reloj de la placa.

6. Vuelva a completar el cronograma siguiente suponiendo ahora que ambos retrasos son menores

que la mitad del periodo, pero que su suma no lo es (Rc < Tp/2, Rr < Tp/2, Rc+Rr > Tp/2).

RELOJ DE LA PLACA

LINEAS DE DIRECCION $FFF

LINEAS DE DATOS

7. En el cronograma anterior, indique los valores de las lineas de direccion y datos que capturaria

el analizador légico si realiza las capturas en los flancos de bajada del reloj de la placa.

8. En el cronograma anterior, indique los valores de las lineas de direccion y datos que capturaria

el analizador légico si realiza las capturas en los flancos de subida del reloj de la placa.
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4. Estudio experimental

La realizaciéon del estudio experimental requerird los siguientes componentes: Analizador 1dgico,
generador de ondas, osciloscopio, fuente de continua, placa de circuito impreso (el lector de ROMs de
Atari 2600) y de cartucho de Atari 2600. El osciloscopio se usard unicamente para chequear la

correccién de las senales de reloj y la alimentacion.

4.1. Montaje y conexion con el instrumental.

La disposicién de los distintos componentes y conectores de la placa con los contadores se muestra

en la Figura 2. En ella puede observarse:

« Un conector donde ha de conectarse la placa con la ROM de Atari 2600. La ROM estara siempre
activa, de manera que en su salidas (sefiales de DO hasta D7) aparece siempre el contenido de la

palabra direccionada.

» Tres contadores de 4 bits (C.I. 74191) que estan conectados en cascada formando un contador

moédulo 4096. Sus 12 bit de salida constituyen la entrada de direccién de la ROM.

« Un conjunto de puntos de conexidon para la alimentacién, la senal de reloj, las de fin de ciclo
(FC2, FC1 y FCO) y las lineas de direccién y datos de la ROM. Con ellos se pueden conectar con

facilidad las sondas del analizador 16gico a las sefiales de interés.
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Figura 2: Distrubicion de los componentes y conectores
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Antes de alimentar la placa con la fuente de continua debe hacerse lo siguiente:

1)

2)

3)

4)

5)

6)

En primer lugar se extraera la placa con la ROM del cartucho y se insertara en el zécalo del
circuito de lectura. ES MUY IMPORTANTE NO INSERTARLA AL REVES: La cara con el chip de
la ROM debe estar orientada hacia los pines de datos DO-D7.

A continuacién se conectardn los terminales del circuito bajo test a las sondas del analizador
que, por otro lado, debera conectarse al ordenador a través del puerto USB. El orden de las

conexiones de las terminales del analizador a la placa se muestra en la tabla siguiente:

Terminal del analizador | Color dél cable | Terminal dela placa
0 marron DO
1 rojo D1
2 naranja D2
3 amarillo D3
4 verde D4
5 azul D5
6 magenta D6
7 gris D7
8 marrén A0
9 rojo Al
10 naranja A2
11 amarillo A3
12 verde A4
13 azul A5
14 magenta A6
15 gris A7
16 marrén A8
17 rojo A9
18 naranja A10
19 amarillo All
20 verde FCO
21 azul FC1
22 magenta FC2

GND negro GND
31 gris CLK

Use el generador de ondas para generar la sefial de reloj. Debe ser una sefial cuadrada de 25
Khz de frecuencia que varie entre 0 y 5 voltios. Ademas debera tener un duty cycle del 50%, es
decir, durante cada ciclo deberd encontrarse la mitad del tiempo en nivel alto y la otra mitad en

nivel bajo. Tendra que emplear el osciloscopio para chequear que la sefal es correcta.

Use el generador de continua para generar la sefial de alimentacidén de 5 voltios. No use el

generador de tension fija (el de la derecha).
Baje el limitador de intensidad (sin situarlo completamente a la izquierda).

Use el osciloscopio para chequear que la alimentacion es de 5 voltios.

Solo después de haber realizado los pasos anteriores debera conectar la alimentacién y la sefial de reloj

a la placa. Tras esto la ROM estard poniendo ciclicamente en su salida el contenido de todas sus

posiciones de memoria.
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4.2. Configuracion del analizador LA-2132 para chequear el circuito

Hay que tener en cuenta que antes de ejecutar el software del LA-2132 debemos conectar el analizador
al puerto USB del PC. Este software, disponible en Windows XP, se ejecuta pulsando sobre el icono LA-

2132 disponible en el escritorio.

A grandes rasgos, la ventana de aplicacion presenta un marco superior que contiene los distintos menus
(File, View, Timing,...), una fila de comandos u opciones que se pueden ejecutar (Go, Stop, ....) y una

ventana dividida en dos partes:

» La parte superior contiene los controles de los cursores/marcadores del sistema, los controles de

zoom y una barra para desplazarnos a lo largo de las capturas.

+ La parte inferior estd dedicada a presentar los datos capturados en los distintos canales de

adquisicion.

Antes de adquirir y visualizar las sefiales de la placa debemos establecer las condiciones de trabajo. Para
ello pulsamos con el botén derecho sobre la ventana inferior y, en la ventana recién aparecida,

seleccionamos las siguientes opciones:

+ En la entrada ‘Trig Word’ (en la que aparecen los canales en el orden 31, 30, 29, .., 0),
escribimos ‘1’ en las posiciones correspondientes a los canales 20, 21 y 22, es decir, los canales
correspondientes a las senales de fin de cuenta. Esto servird para indicar al analizador cuando

debe comenzar a capturar muestras (el estado de cuenta es $FFF si las tres senales valen 1).

« Para establecer que la adquisicion de datos vaya sincronizada con el flanco de bajada del reloj

externo (el de nuestra placa), en la entrada ‘Source’ seleccionamos ‘External falling’.

+ Para que el tamafio de la captura sea de 8K muestras seleccionamos ‘8K’ en la entrada
‘Memory’.

» Para que realice una sola captura seleccionamos ‘Single’ en la entrada ‘Acquire’.

Tras esto cerramos la ventana emergente. Si dejamos la configuraciéon tal y como estd, el analizador
comenzara a capturar cuando las tres sefiales de fin de cuenta valgan uno, es decir, cuando en las lineas
de direccién haya $FFF. A nosotros nos interesa mdas que empiece a capturar cuando la direccién pase a
valer $000, es decir, justo cuando la condicién de disparo pase de ser cierta a ser falsa. Para ello
pulsamos en el botén 'Trigger' y, en la ventana recién aparecida, cambiamos en la fila 'Level 0' la opcién

marcada como 'Enter' a 'Exit'. Tras esto cerramos la ventana.

Por dltimo debemos establecer la agrupacién de canales (mend ‘View’->'Group edit)’. Para cada grupo
de canales hay que establecer su nombre (entrada ‘Name’), base en la que se visualizara el valor de sus
canales (entrada ‘Base’), nimero de canales que lo forman (entrada ‘Number’) y cuales son dichos
canales. Para cambiar de grupo se pulsa sobre las flechas de la parte superior de la ventana. Se crearan
cuatro grupos. El primero, llamado 'contenido', estara constituido por los 8 bits correspondientes a la
salida de la ROM y se mostrard en hexadecimal. El segundo, llamado ‘direccién’ estard constituido por

los 12 bits correspondientes a las entradas de direccion de la ROM y se mostrard también en
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hexadecimal. El tercero, llamado 'Fin Cuenta' contendrd las senales de fin de cuenta de cada uno de los
tres contadores y se mostrara en binario. El cuarto y ultimo grupo, llamado 'reloj', contendra inicamente

la sefial de reloj de la placa (canal 31) y se mostrard en binario.

Una vez modificados todos estos menus se puede pasar a la adquisicién de los datos. Para ello pulse la
tecla 'Go' y comenzara la adquisicién al ritmo marcado por el reloj. Tras finalizar la adquisicion
apareceran actualizados los datos capturados en la pantalla. Con la configuracion sefialada se
capturaran las seflales en cada flanco de bajada del reloj externo. Para chequear que ha ido todo bien,

compruebe lo siguiente:

« El valor de las lineas de direccion, al ser la salida de un contador controlado por el reloj de la
placa, debe incrementarse en cada captura. Sus formas de onda deben ser sefales cuadradas,

cada una de ellas de periodo doble a la anterior.

+ Las tres senales de fin de cuenta se pondran simultdneamente a uno Unicamente cuando el

contador esté en el ultimo estado de cuenta.

Ademads hay que testear que en las lineas de datos se pone, de forma secuencial, el contenido de cada
posicion de la ROM. Dado que se trata de una ROM de Atari 2600, esto puede comprobarse guardando
los datos capturados y pasandolos a un emulador tal y como se describe a continuacion.

1. Para guardar las capturas del analizador en un fichero debemos hacer lo siguiente:

1.1. En el menu del software del analizador seleccionamos ‘File'->'Save data'->'Save data

’

as’.

1.2. Elegimos un directorio (por ejemplo ‘c:\roms’) y elegimos un nombre de archivo.
Conviene que el nombre tenga menos de 8 caracteres para acceder a él directamente desde

la linea de comandos.

2. Ahora debemos extraer de dicho archivo los valores correspondientes a las lineas de datos y
grabarlos en un fichero binario legible por el emulador de la forma siguiente:

2.1. abrimos una ventana de linea de comandos accediendo al menu de inicio de Windows

('Inicio'->'Todos los programas'->'Accesorios' ->'Simbolo del sistema').

2.2, ejecutamos esto:

cd directorio con el fichero salvado
dso2bin archivo original.dso fichero salida.bin

Es muy importante dar al fichero de salida un nombre que termine en la extensiéon ‘.bin’ para

que pueda leerlo el emulador Stella

3. Finalmente comprobaremos el volcado con el emulador Stella. Para ello:
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3.1. Se pulsa sobre su icono en el escritorio.
3.2. Dentro del emulador se hace doble click sobre el fichero previamente creado.
3.3. Se comprueba que en efecto el programa de Atari funciona. Las teclas basicas son F2

(start, comienzo de partida), espacio (disparo), y los cursores.

4.3. Comprobacion del estudio teorico

1) Para ver el listado de muestras seleccione 'View'->'State of logic analyzer'. Pulse sobre el botén
'T' situado a la izquierda de las muestras para situarse en la muestra donde se produjo el
disparo. Apunte algunas de las direcciones de memoria que aparecen en la pantalla (en

particular la $000), asi como el contenido correspondiente.

2) Cambie el modo de adquisicion de datos en el analizador 16gico para que realice las capturas a
una frecuencia cuatro veces superior a la del reloj de la placa (‘Source'->'Internal'->'Rate'-

>'100Ks'). Verifique experimentalmente su respuesta al punto 3 del estudio tedrico.

3) Cambie la frecuencia del reloj interno del analizador a 250Mhz y vuelva a capturar. Mida

aproximadamente el retraso del contador de 12 bits (Rc) y de la ROM (Rr).
4) Para verificar experimentalmente las respuestas a los puntos 6 y 7 haga lo siguiente:

4.1)Cambie de nuevo el modo de adquisicién de datos para que la captura se realice en los
flancos de bajada del reloj de la placa (‘External falling’) y para que el analizador realice

ciclicamente capturas sin detenerse (modo de disparo 'Normal').

4.2)Pulse 'Go' para iniciar las capturas y aumente poco a poco la frecuencia del reloj de la placa.

Deténgase justo cuando los datos anotados en el apartado 1 no se capturen correctamente.

4.3)Calcule el periodo del reloj de la placa y compruebe si se cumple la desigualdad del apartado

6 del estudio tedrico.

5) Cambie de nuevo el modo de adquisiciéon de datos para que la captura se realice en los flancos
de subida del reloj de la placa. Use los datos anotados en el apartado 1 para verificar

experimentalmente su respuesta al punto 8 del estudio tedrico.
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Anexo: descripcion del contador comercial 74191

El componente 74191 es un contador de 4 bits. A parte de sus salidas de estado (Q) y sus entradas de
datos para carga en paralelo (P) dispone de las siguientes sefiales:

« CE (Count Enable, entrada): es la sefial de habilitacion de cuenta (activa en bajo).

« U/D (Up/Down, entrada): indica si la cuenta serd ascendente (valor 0) o descendente (valor 1).
+ CP (Clock Pulse, entrada): es la sefial de cuenta y es activa en el flanco de subida.

¢ TC (Terminal Count, salida): indica el fin del ciclo de cuenta (se activa en el estado 1111).

* RC (Ripple Clock, salida): En el ultimo estado de cuenta es igual a CP. En los demés vale 1.

+ PL (Parallel Load, entrada): Cuando vale cero el contador realiza una carga en paralelo.



